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Kurzbeschreibung

Der netNODE ist ein Ethernet Gateway. Es ist modular
aufgebaut und bietet neben einer Ethernet Schnittstelle
bis zu drei serielle Schnittstellen. 

Das eingebaute Display zusammen mit den Cursor-
Tasten erlauben eine Parametrierung und Inbetriebnah-
me vor Ort ohne weitere Hilfsmittel.

Alternativ kann die Parametrierung und Inbetriebnahme
mittels des Systemkonfigurators SyCon über einen PC
erfolgen, der über die serielle Diagnoseschnittstelle
oder das Ethernet-Netzwerk angeschlossen wird.

Die Gateway-Funktion besteht aus einem transparenten
Austauschen der Protokolldaten über ein TCP/IP-Tele-
gramm. Für Applikationen mit weitergehenden Anforde-
rungen lässt sich der Funktionsumfang mit Hilfe des
grafischen Programmiersystems iCon-L leicht erwei-
tern, womit ohne weitergehende Programmierkenntnis-
se die Messages (die Sende-und Empfangstelegramme
werden geräteintern als Message dargestellt) anhand
von Bausteinen vom Anwender selbst bearbeitet wer-
den können.

Zur Installation, Konfiguration und Bedienung des net-
NODE gibt es weitere Manuals. Diese finden Sie eben-
falls auf der netDEVICEs System Software CD. Folgen-
de Manuals sind vorhanden:

netNODE für netNODE 40/42
Inbetriebnahmeleitfaden und Bedienungs-
anleitung für netNODE Geräte

SyConND Systemkonfigurator netDEVICE
Konfiguration und Diagnose mit dem
Systemkonfigurator SyCon

Description

The netNODE is an Ethernet Gateway. It is modularly
structured and offers in addition to an Ethernet interface
up to three serial interfaces. 

The built-in display together with the cursor keys permit
parameterisation and start-up without any additional
tools.

Alternatively the parameterisation and start-up can be
done with the System Configurator SyCon via a PC,
which is connected by the serial diagnostic interface or
the Ethernet network.

The Gateway function consists of a transparent exchan-
ge of the protocol data via a TCP/IP telegram. Applicati-
ons that extend beyond this range can be easily impe-
mented with the aid of the graphical programming
system iCon-L with which the user is able to process
messages (Send- and receive telegrams are displayed
as message device internal) with graphical function
blocks without programming knowledge.

There are further manuals for installation, configuration
and operating with the netNODE. This manuals you
also find on the netDEVICEs System Software CD. The
following manuals are available:

netNODE for netNODE 40/42
start-up guide and operating instruction for
netNODE devices

SyConND System Configurator netDEVICE
Configuration and Diagnostic with the 
System Configurator SyCon
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Verzeichnisstruktur der CD

Sie erhalten auf dieser CD alle Dokumentationen im
Adobe-Acrobat-Reader-Format (PDF). Im Verzeichnis
ACROREAD ist eine Runtime-Version enthalten.

Directory Structure of the CD

All manuals on this CD are delivered in the Adobe
Acrobat Reader format (PDF). A runtime version of this
reader can be found in the ACROREAD directory.

Installation des Acrobat Readers
Installation of Acrobat Reader

Dokumentation zum netNODE und
SyCon im Acrobat Reader Format
Documentation of netNODE and SyCon
in Acrobat Reader format

Installation des Systemkonfigurators
SyCon
Installation of the System Configurator-
SyCon

Installation des Hilscher IP Treibers
Installation of the Hilscher IP Driver

Dokumentation zu den Treibern
Dokumentation for the Drivers
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CD-Inhalt

• ladbare Firmware*
• Hilscher TCP/UDP IP Treiber
• Systemkonfigurator SyCon
• iCon-L**
• die Dokumentation

für unsere netNODE Gateways. 

Die Erstinbetriebnahme erfolgt durch den Systemkonfi-
gurator SyCon. Dazu ist eine serielle Verbindung zwi-
schen der Diagnoseschnittstelle des netNODEs und
dem COM-Port des PCs herzustellen. Das hierfür ver-
wendetet Kabel trägt die Bezeichnung CAB-NN.

Mit dem Systemkonfigurator SyCon ist dann 
• die Firmware
• die Konfiguration (incl. IP-Adresse) sowie
• die Grundgatewayfunktion (Image Datei)
in den netNODE zu laden.

Eine Konfiguration und Diagnose ist nun auch über das
netNODE Display mittels der Cursortasten möglich. Die
Konfiguration wird auf dem Gateway gespeichert, so
dass dieses beim Starten sofort betriebsbereit ist.

Alternativ kann vom SyCon die Konfiguration bzw. Dia-
gnose über eine TCP/IP Verbindung zum net durchge-
führt werden.

*  Falls es eine neue Firmwareversion gibt, können Sie
diese von unserer Homepage herunterladen.

** Zum Betrieb der lizensierten Version der Bausteinbi-
bliothek iCon-L benötigen Sie einen Lizenzcode.
Wenn dieser im Lieferumfang mit enthalten ist, finden
Sie ihn als Label auf dieser CD. Andernfalls wenden
Sie sich bitte an Ihren Distributor oder direkt an uns.

CD Content

• loadable Firmware*
• Hilscher TCP/UDP IP Driver
• System Configurator SyCon
• iCon-L**
• Documentation 

for our netNODE Gateways. 

The initial start-up takes place via the System Configu-
rator SyCon. For this it is necessary to built up a serial
connection between the diagnostic interface of the net-
NODE and the COM-Port of the PC. The cable which is
used for this has the designation CAB-NN.

With the System Configurator SyCon
• the firmware
• the configuration (incl. IP Address) as well as
• the basic gateway function (Image file)
has to be loaded in the netNODE.

A configuration and diagnostic is now also possible via
the netNODE display by means of the cursor keys. The
configuration is stored on the Gateway, therefore it is
immediately ready for operation after the start.

Alternatively the configuration and diagnostic can be
done via a TCP/IP connection to the netNODE.

*  If there are new firmware versions available you can
download it from our homepage.

** A license code is required to use the licensed version
of the module library iCon-L. If this is included in the
scope of delivery you will find it on a label on this CD. 
Otherwise please call your distributor or us directly.



Systemvoraussetzungen

• PC mit 586-, Pentium-Prozessor oder höher
• Windows 98/ME, Windows NT 4.0/2000/XP
• Freien Festplattenspeicher: 30 - 80 MByte
• CD-ROM-Laufwerk
• RAM: mind. 16 MByte
• Grafikauflösung: mind. 800 x 600 Bildpunkte
• Windows NT: Service Pack 3 oder höher
• Tastatur und Maus 

Installation des netNODEs

Das netNODE wird auf eine Tragschiene nach DIN EN
50022 befestigt und mit 24 V Betriebsspannung ver-
sorgt. 

Die Erdung erfolgt über den Erdungskontakt zur Hut-
schiene an der Rückseite des Geräts.

An den seriellen Schnittstellen des netNODE 40 und
des netNODE 42 ist RS232C, RS422 und RS485 mög-
lich.

System Requirements

• PC with 586-, Pentium processor or higher
• Windows 98/ME, Windows NT 4.0/2000/XP
• Free disk space: 30 - 80 MByte
• CD ROM drive
• RAM: min. 16 MByte
• Graphic resolution: min. 800 x 600 pixel
• Windows NT: Service Pack 3 or higher
• Keyboard and Mouse 

Installation netNODE

The netNODE is mounted on a DIN rail according to
DIN EN 50022 and it is supplied with an operating volta-
ge of 24 V.

The grounding is made by the earth terminal to the DIN
rail at the back side of the device.

On the serial interfaces of netNODE 40 and netNODE
42 RS232Cs, RS422 and RS485 are possible.
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Typ Ethernet Schnittstelle Serielle Schnittstelle

Type Ethernet Interface Serial Interface
netNODE 40 1 Schnittstelle / 1 Interface 1 Schnittstelle / 1 Interface
netNODE 42 1 Schnittstelle / 1 Interface 3 Schnittstellen / 3 Interfaces
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Hinweis: Die seriellen Schnittstellen X3 und X4 sind
nur bei netNODE 42 Geräten vorhanden. Bei netNODE
40 gibt es nur die serielle Schnittstelle X5. Die Schnitt-
stelle X2 ist für zukünftige Erweiterungen vorgesehen
und ist derzeit nicht vorhanden.

Gerätezeichnung Device Drawing

Note: The serial interfaces X3 and X4 are only availa-
ble for netNODE 42 devices. For netNODE 40 just the
serial interface X5 exists. The interface X2 is reserved
for future use.

Anschlüsse Betriebsspannung

Connections power supply
Ground

24 V

X5 1. serielle Schnittstelle / 1. serial Interface COM 1

X4 2. serielle Schnittstelle / 2. serial Interface COM 2

X3 3. serielle Schnittstelle / 3. serial Interface COM 3
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Das eingebaute Display zusammen mit den Cursor
Tasten erlauben eine Parametrierung und Inbetriebnah-
me des netNODE Gerätes ohne weitere Hilfsmittel. Vor-
aussetzung dazu ist, dass bereits die Firmware, eine
Konfiguration und die Gatewayfunktion (Image Datei) in
das netNODE geladen wurde. Up

Down

Right
Left

The built-in display together with the cursor keys permit
parameterisation and start-up without any additional
aids. A condition for it is that the firmware, a configurati-
on and the gateway function (image file) were already
loaded into the netNODE. 

Die Cursor Tasten des netNODEs sind:
Mit den Tasten Up und Down kann man
zwischen den verschiedenen Haupt-
menüs wechseln.
Die Tasten Right und Left werden ver-
wendet, um in den Untermenüs Para-
meter zu editieren.
Mit der Taste ESC verlässt man das
aktuelle Menü und kehrt in das überge-
ordnete Menü zurück.
Mit der Taste OK wechselt man in das
im Display angezeigte Untermenü.

The cursor keys of the netNODE are:
With the keys Up and Down you can

change between the different main
menus.

The keys Right and Left are used for
processing the parameter in the sub-

menus.
With the ESC key you leave the actual
menu and change in the higher menu.

With the OK key you change in the
submenu which is shown in the display.

Die Tastatur The Keys

Der DIP-Schalter The DIP Switch

Der DIP-Schalter wird verwendet, um die Abschluss-
Widerstände der seriellen Schnittstelle X5 (1. serielle
Schnittstelle) ein- bzw. auszuschalten. 
Sind alle Schalter auf OFF geschaltet, ist keine Termi-
nierung vorhanden. Sind die Schalter alle auf ON
geschaltet, ist eine Terminierung für RS422 bzw. RS485
vorhanden.
Bei eingeschalteter Terminierung beträgt der Terminie-
rungswiderstand 120 Ohm. Auch die Pullup/Pulldown
Terminierung ist mit 470 Ohm ebenfalls aktiv.

The DIP Switch is used to switch the termination resi-
stors of the serial interface X5 (1. serial interface) on
and off.
If all switches are turned to OFF no termination exists. If
the switches are turned to ON there is termination for
RS422 and respectively RS485.
If the termination is switched on, the termination resi-
stance is 120 ohm. Also the pullup/pulldown termination
with 470 ohm is active.

DIP-Schalter auf ON
geschaltet (Schalter sind
alle oben)

DIP-Schalter auf OFF
geschaltet (Schalter sind
alle unten)

DIP Switch is ON (all
switches are at the top)

DIP Switch is OFF (all
switches are at the bot-
tom)

Die Beschreibung der Menüstruktur finden Sie im
Bedienermanual netNODE auf der netDEVICEs CD im
Verzeichnis CD:\Manuals\Deutsch\netNODE_de.pdf.

The description of the menu structure you find in the
operating manual netNODE on the netDEVICEs CD in
the directory CD:\Manuals\English\netNODE_en.pdf.



10

Ethernet-Schnittstelle

Ethernet Kabelbelegung am RJ45-Stecker.

Für die Ethernet Schnittstelle verwendet man RJ45
Stecker und Twisted Pair Kabel, welches aus 4 paar-
weise verdrillten Adern besteht.

Man unterscheidet zwischen STP (geschirmtes Twisted
Pair) und UTP (ungeschirmtes Twisted Pair). Der Unter-
schied zwischen geschirmt und ungeschirmt ist, dass
bei UTP nur ein Schirm um das gesammte Kabel
besteht. Bei STP ist jedes Adernpaar innerhalb des
Kabels nochmals einzeln geschirmt. 

Als Übertragungsmedium wird Twisted Pair Kabel der
Kategorie 3 oder 5 verwendet, welches eine Übertra-
gungsrate von 10 bzw. 100 MBit/s hat.

Es wird die Verwendung von Kategorie 5 Kabeln emp-
fohlen.

Ethernet Interface

Ethernet cable connection to the RJ45 plug.

For the Ethernet interface you use RJ45 plugs and Twi-
sted Pair cable which consists of 4 twisted cores.

You can distinguish between STP (shielded Twisted
Pair) and UTP (unschielded Twisted Pair). The differen-
ce between shielded and unshielded is, that in case of
UTP only one shield is around the whole cable. In case
of STP each core pair is shielded separately.

As transmission medium Twisted Pair cable category 3
or 5 is used which has a transmission rate of 10 and
respectively 100 MBit/s.

It is recommended to use cable of category 5.

Anschluss mit RJ45 Stecker Signal Bedeutung

Connection with RJ45 plug Signal Meaning
1 TXD+ Sendetaten + / Transmitt Data +
2 TXD- Sendedaten - / Transmitt Data -
3 RXD+ Empfangsdaten + / Receive Data +
4 - unbenutzt / not used
5 - unbenutzt / not used
6 RXD- Empfangsdaten - / Receive Data -
7 - unbenutzt / not used
8 - unbenutzt / not used
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Direkter Anschluss / Direct Connection

Anschluss über Hub/Switch / Connection via Hub/Switch

TXD+

TXD-

RXD+
RXD-

TXD+

TXD-

RXD+
RXD-

Hub / Switch

TXD+

TXD-

RXD+
RXD-

TXD+

TXD-

RXD+
RXD-

Ethernet Anschluss Daten / Ethernet Connection Data
Anzahl der Geräte / Durch IP-Adressraum begrenzt / limited by the number of IP Addresses
Number of devices
Medium 4 x 2 Twisted Pair Kupferkabel Kat 3 (10 MBit/s), Kat 5 (100 MBit/s) /

4 x 2 Twisted Pair copper cable Cat 3 (10 MBit/s), Cat 5 (100 MBit/s)
Leitungslänge / Length of cable zum Hub oder Switch max. 100m / to Hub or Switch max. 100m
Übertragungsrate / Transmission rate 10 MBit/s

Topologie / Topology Sternförmige Verkabelung / Star Topology
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Serielle Schnittstelle Serial Interface

DSub-Stecker RS232C RS422 RS485 Eingang/Ausgang Bedeutung

Connector male Signal Signal Signal Input /output Meaning
1 - - RxD/TxD-N Eingang/Ausgang Sendedaten invertiert

Input/Output Transmit data inverted
TxD-N Ausgang/Output Daten invertiert /

data inverted
2 RxD - - Eingang / Input Empfangsdaten / 

Receive Data
3 TxD - - Ausgang / Output Sendedaten /

Transmit Data
4 - RxD-P - Eingang / Input Empfangsdaten / 

Receive Data
5 RGND RGND RGND Bezugspotential /

Ground
6 - - RxD/TxD-P Eingang/Ausgang Sendedaten / 

Output/Input Transmit Data
TxD-P Ausgang / Output Daten / Data

7 RTS - - Ausgang / Output Sendeteil einschalten

Ready to Send
8 CTS - - Eingang / Input Sendebereitschaft

Clear to Send
9 - RxD-N - Eingang / Input Empfangsdaten

invertiert

Receive Data 
inverted

Bei Verwendung der RS232 Schnittstelle muss das Sig-
nal CTS (Pin 8 - Sendebereitschaft) aktiviert, dass heißt
auf High-Pegel gelegt werden. Dies kann zum Beispiel
durch Verbinden der Pins 4, 6 und 8 im Stecker gesche-
hen.

In the case of the RS232 interface the signal CTS (pin 8
- Clear to Send) must be activated, that means it need
to be set on High Level. This can take place for exam-
ple by means of connecting the pins 4, 6 and 8 in the
connector. 
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RS232C

Schnittstelle RS232C

Verwendung für Punkt-zu-Punkt-Verbindungen

zwischen zwei Kommunikations-

geräten

Kabel LIYCY 3 x 0,25 qmm

max. Kabellänge 15 m (bei max. 19,2 kBit/s)

max. Geräte 2

RS422

Schnittstelle RS422

Verwendung Bus (Multipunkt) oder Punkt-zu-

Punkt-Verbindungen

Kabel LIYCY 2 x 2 x 0,25 qmm

max. Kabellänge 1200 m (bei max. 19,2 kBit/s)

Wellenwiderstand 100-150 Ohm

Kapazitätsbelag ca. 60 pF/m

RS485

Schnittstelle RS485

Verwendung Bus (Multipunkt) oder Punkt-zu-

Punkt-Verbindungen

Kabel LIYCY 2 x 2 x 0,25 qmm abge-

schirmtes, verdrilltes Kabel

Wellenwiderstand 100-120 Ohm

Kapazitätsbelag ca. 60 pF/m

max. Geräte 32 (ohne Repeater)

RS232C

Interface RS232C

Using for point to point connections

between two communication

devices

Cable LIYCY 3 x 0,25 qmm

max. Cable Length 15 m (for max. 19.2 kBit/s)

max. Devices 2

RS422

Interface RS422

Using Bus (multipoint) or for point to 

point connections

Cable LIYCY 2 x 2 x 0,25 qmm

max. Cable Length 1200 m (at max. 19.2 kBit/s)

Wave Resistance 100-150 Ohm

Capacity ca. 60 pF/m

RS485

Interface RS485

Using Bus (multipoint) or for point to 

point connections

Cable LIYCY 2 x 2 x 0.25 qmm 

shielded, twisted cable

Wave Resistance 100-120 Ohm

Capacity ca. 60 pF/m

max. Devices 32 (without Repeater)
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Diagnoseschnittstelle

Potentialfreie RS232C zum Anschluss an die COM-
Schnittstelle des PCs.

Diagnostic Interface

Isolated RS232C to connect with the 
COM port of the PC.

Anschluss mit 9 poligem DSub-Stecker Signal Bedeutung

Connection with 9 pin DSub male connector Signal Meaning
1 - unbenutzt / not used
2 RxD Empfangsdaten / Receive Data
3 TxD Sendedaten / Send Data
4 DTR Datenendeinrichtung betriebsbereit

Data Terminal Ready
5 GND Betriebserde / Signal Ground
6 - unbenutzt / not used
7 RTS Sendeteil einschalten / Ready to Send
8 CTS Sendebereitschaft / Clear to Send
9 - unbenutzt / not used

Hinweis: Für die Verbindung des PCs mit der Diagno-
seschnittstelle des netNODEs wird ein spezielles Kabel
der Firma Hilscher benötigt. Bei diesem Kabel befindet
sich die für die Verbindung benötigte Elektronik im
Anschluss-Stecker des Kabels. Die Bestellbezeichnung
für das netNODE Diagnose-Kabel ist CAB-NN.

Note: You need a special cable from the company Hil-
scher to connect the PC with the diagnostic interface of
the netNODE. By this cable the used electronic for the
connection is inside the plug of the cable. The order
designation for the netNODE diagnostic cable is CAB-
NN.
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Software Installation

Close all application programs on the system!

Insert the netDEVICE CD in the local CD ROM drive.
The installation program will start by itself (Autostart
enabled). Otherwise change into the root directory of
the CD and start Autorun.exe (Autostart disabled).

NOTE Administrator privileges are required on
Windows NT/2000/XP systems for installation!

The installation program ask for the components you
want to install. Answer these questions with Yes or No. 

It can be installed

• System Configurator SyConND
• iCon-L
• Hilscher IP Driver.

For the System Configurator SyCon no license code is
required because the basic version includes all func-
tions for the operation of the netNODE.

If you have a license code for iCon-L or a license code
is labeled on the CD, then answer the question for an
existing license code with Yes. Further enter your name
and the company name. 
If you answer the question for a license code with No,
the basic version of iCon-L will be installed. 

Follow the instructions of the installation program and
answer all the questions with OK or NEXT.

Installation der Software

Schließen Sie alle Programme!

Legen Sie die netDEVICE CD in das lokale CD-ROM-
Laufwerk. 
Das Installationsprogramm startet selbständig
(Autostart eingeschaltet). Andernfalls wechseln Sie 
in das Root Verzeichnis der CD und starten Sie
Autorun.exe (Autostart ausgeschaltet).

HINWEIS Unter Windows NT/2000/XP benötigen Sie
Administratorrechte zur Installation!

Das Installationsprogramm fragt, welche Komponenten
installiert werden sollen. Beantworten Sie diese Fragen
mit Ja bzw. Nein. 

Es können installiert werden

• Systemkonfigurator SyConND
• iCon-L
• Hilscher IP Treiber.

Für den Systemkonfigurator SyConND wird keine
Lizenz benötigt, da die Basisversion alle Funktionen
zum Betrieb des netNODE beinhaltet.

Wenn Sie einen Lizenzcode für iCon-L haben oder ein
Lizenzcode auf der CD angegeben ist, dann beantwor-
ten Sie die Frage nach einem vorhandenen Lizenzcode
mit Ja. Geben Sie weiter Ihren Namen und den Firmen-
namen ein.
Beantworten Sie die Frage nach einem Lizenzcode mit
Nein, wird die Basisversion des iCon-L installiert.

Folgen Sie den Anweisungen des Installationsprogram-
mes und beantworten die Fragen mit JA oder WEITER.
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Installation SyCon

Bei der Frage nach dem Lizenzcode wählen Sie bitte
das Feld Nein an, da keine Lizenz benötigt wird. Es
wird die Basisversion des Systemkonfigurators instal-
liert, die alle Funktionen zum Betrieb des netNODE ent-
hält.

Installation iCon-L

Bei der Installation der lizensierten Version von iCon-L
müssen Sie Ihren Namen und den Firmennamen einge-
ben. Wenn Sie einen Lizenzcode haben oder dieser auf
der CD angegeben ist, dann geben Sie diesen bitte jetzt
ein.
Wenn Sie keinen Lizenzcode haben, arbeitet die Bau-
steinbibliothek iCon-L nur als Basisversion. 

Sie haben auch die Möglichkeit einen Lizenzcode für
iCon-L nachträglich zu bestellen. Unter dem Menüpunkt
Hilfe > Lizensierung im Systemkonfigurator können
Sie ein Bestellformular für Ihre Lizenz ausfüllen und an
Ihren Distributor oder direkt an uns faxen.

Die Basisversion des iCon-L hat folgenden Funktions-
umfang:
• Vorhandene Projekte öffnen, Parameter von Baustei-

nen ändern und in den netNODE laden
• Diagnosefunktionen für vorhandene Projekte
• Bausteine können nicht entfernt bzw. hinzugefügt

werden!

Die lizensierte Version des iCon-L hat folgenden Funkti-
onsumfang
• Projekte mit bis zu 100 Bausteinen erzeugen
• Projekte neu anlegen und vorhandenen öffnen, Para-

meter von Bausteinen ändern und in den netNODE
laden

• Diagnosefunktionen
• Bausteine können entfernt und hinzugefügt werden

Installation of SyCon

With the question about the license code please select
the field No, because no license is needed. The basic
version of the System Configurator is installed, which
contains all functions for operating the netNODE. 

Installation iCon-L

During the installation of the licensed version of iCon-L
you have to type in the user and the company name. If
you have a license code or it is labled on the CD, it
must also be entered now.
If you have no license code, the module library iCon-L
will work as a basic version. 

You also have to possibility to order a license code for
iCon-L subsequently. With the menu item Help > Licen-

sing in the System Configurator you can fill out an
order form and send it to your distributor or directly to
us.

The basic version of iCon-L has the following scope of
functions:
• Open extisting projects, change parameter of modu-

les and load it into the netNODE
• Diagnostic functions for exsting projects
• Modules can not be deleted or added!

The licensed version of iCon-L has the following scope
of functions:
• Produce projects with up to 100 modules
• Create new projects and open existing projects, chan-

ge parameter of the modules and load it into the net-
NODE

• Diagnostic functions
• Modules can be deleted or added
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Installation des IP-Treibers

Wählen Sie Hilscher IP Treiber aus dem Installations-
menü oder starten Sie aus dem CD Verzeichnis
\TcpUdpIp Driver das Programm IpDrvSetup.exe.

Nach der Installation muss der Hilscher IP Treiber ent-
sprechend dem netNODE konfiguriert werden. Das
heißt, es müssen die IP Adresse und die Port Nummer
des netNODEs angegeben werden, wie im nächsten
Abschnitt beschrieben.

Konfiguration des 
IP-Treibers

Starten Sie das Konfigurationsprogramm des Hilscher
IP Treibers mit Start > Programme > Hilscher IP Dri-

ver > IP Driver Setup.

Geben Sie die konfigurierte IP-Adresse des netNODE
in das Feld IP-Address sowie die Port Nummer in das
Feld Port ein (Um den netNODE eine IP-Adresse zuzu-
weisen, lesen Sie Abschnitt ‘Einstellen der IP-Adresse’
auf Seite 20). Abweichend von den Standardeinstellun-
gen können noch folgende Änderungen vorgenommen
werden:

Port:

Arbeitet der Treiber im Client Modus, muss hier die
Portnummer des netNODE angegeben werden unter
der das Gerät angesprochen werden kann. 
Arbeitet der Treiber als Server, wird hier der Port ange-
geben auf welchem der Treiber auf eingehende Verbin-
dungen vom netNODE wartet (Grundeinstellung: 1099,
Treiber arbeitet als Client).

Protocol:

Hier kann parameteriert werden, mit welchem Protokoll
die Kommunikation stattfinden soll, TCP/IP oder
UDP/IP. Als Grundeinstellung ist TCP/IP ausgewählt.

Installation of the IP Driver

Select Hilscher IP Driver in the installation menu or
start the program IpDrvSetup.exe from the CD direc-
tory \TcpUdpIp Driver.

After the installation the Hilscher IP Driver has to be
configured according to the netNODE. That means you
have to type in the IP address and the Port number of
the netNODE, as described in the next section. 

Configuration of the 
IP Driver

Start the configuration program of the Hilscher IP Driver
with Start > Programs > Hilscher IP Driver > IP Driver

Setup.

Enter the configured IP Address of the netNODE in the
field IP Address and the Port number in the field Port

(To assign an IP Address to the netNODE, read section
‘Set the IP Address’ at page 20). Deviating from the
standard settings the following changes can also be
made: 

Port:

If the driver works in Client mode, you have to set here
the Port number under which the device can be addres-
sed.
If the driver works as Server, here the Port number is
given, on which the driver waits for a receiving connec-
tion from the netNODE (Default setting: 1099, driver
works as Client).

Protocol:

Here you can parameterize with which protocol the
communication should take place, TCP/IP or UDP/IP.
As default setting TCP/IP is selected.
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Mode: 

Das Feld Mode dient zur Einstellung des Modus in dem
der Treiber arbeitet (Client oder Server). 
Arbeitet der Treiber als Client, wird der Verbindungsauf-
bau zum eingestellten Gerät aktiv durch den Treiber
vorgenommen.
Ist als Mode Server gewählt, wartet der Treiber auf ein-
gehende Verbindungen des eingestellten Gerätes
(Grundeinstellung: Client).

Connect Timeout (ms):

In diesem Feld wird im Client Modus angegeben, wie
lange versucht wird eine Verbindung mit dem eingestell-
ten Gerät herzustellen.
Im Server Modus gibt dieses Feld an, wie lange auf
eine eingehende Verbindung des parametrierten Gerä-
tes gewartet werden soll.

Hinweis: Wenn diese Einstellung später nochmals 
geändert werden soll, ist das Menü Start > 

Programme > Hilscher IP Driver > IP Driver 

Setup erneut aufzurufen und Programme, 
welche den Treiber benutzen, müssen 
ebenfalls neu gestartet werden.

Mode:

In the field Mode you can set in which mode the driver
works (Client or Server).
If the driver works as Client, the connection built up is
done active by the driver.
If the mode Server is selected, the driver waits for recei-
ving connections of the set device (Default setting: Cli-
ent).

Connect Timeout (ms):

In this field is set in the Client mode, how long it is tried
to built up a connection with the set device.
In Server mode it gives how long it should be waited for
a received connection of the paramerized device.

Note: If it is necessary to change the configuration 
later on, you have to restart the menu Start > 

Programs > Hilscher IP Driver > IP Driver 

Setup again and also the programs which 
use the driver have to be restarted.
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Aufrufen des TCP/UDP IP
Treibers

Von eigenen Windows Applikationen können Sie den
Treiber benutzen, um auf die Mailboxen bzw. das Pro-
zesabbild (soweit vorhanden) des netNODE zuzugrei-
fen.

Das Manual DRV_IP.PDF beschreibt alle Funktionen
des TCP/UDP IP Treibers. Die protokollspezifischen
Befehle und Datenstrukturen sind jeweils in einem eige-
nem Manual beschrieben. Wenn Sie einen eigenen
Treiber schreiben möchten, bieten wir eine Beschrei-
bungen mit einer genauen Definition der Schnittstelle
(API) an.

Die Protokoll Interface Manuals finden Sie auf der net-
DEVICE CD im Verzeichnis CD:\Api\Manuals\Pintfa-
ce\...

Die Manuals DRV_IP.PDF und DEVDRV.PDF finden
Sie auf der netDEVICE CD im Verzeichnis
CD:\Api\Manuals\Driver\....

Using the TCP/UDP IP
Driver

From own Windows applications you can use the driver
to get access to the mailbox and/or the process data
image of the netNODE (if available).

The Manual DRV_IP.PDF describes all functions of the
TCP/UDP IP driver. The protocol specific commands
and data structures are described presenty in their own
manuals.
If you want to write your own driver, we provide a detai-
led description of the interface (API).

The Protocol Interface Manuals are on the netDEVICE
CD in the directory CD:\Api\Manuals\Pintface\...

The  DRV_IP.PDF and DEVDRV.PDF manuals you find
on the netDEVICE CD in the directory
CD:\Api\Manuals\Driver\....

Inhalt / Subject Manual

Programmieranleitung zum Hilscher IP Treiber DRV_IP.PDF

How to use the Hilscher IP Driver
Programmieranleitung zum Hilscher Device Treiber DEVDRV.PDF

How to use the Hilscher Device Driver
Protocol Interface Manual NetIdent NI_PIE.PDF

Protocol Interface Manual Protokolle STD_PIE.PDF

ASCII, 3946R, RK512, Modbus RTU
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Einstellen der IP-Adresse

Im Auslieferungszustand hat der netNODE die IP-
Adresse 0.0.0.0. Um eine IP-Adresse einzustellen ist im
Systemkonfigurator SyCon das Menü Einstellungen >

Gerätezuordnung > TCP/IP Driver > NetIdent Konfi-

guration aufzurufen. Alternativ kann auch Start > Pro-

gramme > Hilscher IP Driver > NetIdent Demo Pro-

gram verwendet werden. 

Mit der Schaltfläche Geräte finden/Start Poll wird das
Netzwerk nach Geräten (netDEVICEs) gescannt. Wer-
den ein oder mehrere Geräte gefunden, werden diese
in der Liste mit ihrer MAC-ID angezeigt.

Hat das Gerät schon eine IP-Adresse wird diese im
Feld IP-Adresse angezeigt. Ist die angezeigte IP-
Adresse 0.0.0.0, muss dem Gerät mit der Schaltfläche
IP-Adresse setzen/SetIP eine Adresse zugewiesen
werden. Zum manuellen Ändern einer vorhandenen IP-
Adresse markiert man das Gerät in der Liste und wählt
die Schaltfläche IP-Adresse setzen/SetIP.

Wenn die IP-Adresse eingegeben ist, bestätigt man in
diesem Fenster mit der Schaltfläche IP-Adresse set-

zen/SetIP, um dem netNODE diese Adresse zuzuwei-
sen.

Set IP Address

On delivery the netNODE has the IP address 0.0.0.0.
To set an IP Address, you have to select the menu Set-

tings > Device Assignment > TCP/IP Driver > NetI-

dent Configuration in the System Configurator SyCon.
Alternatively you can also use Start > Programs > Hil-

scher IP Driver > NetIdent Demo Program.

With the button Start Poll the network is scanned for
devices (netDEVICEs). If one or more devices were
found, they are shown with their MAC-ID in the list.

If the device already has an IP Address this is shown in
the field IP Address. If the shown IP Address is 0.0.0.0,
an IP Address has to be assigned to the device with the
button SetIP. 
For manual changing of an existing IP address you
have to mark the device in the list and then select the
SetIP button. 

If the IP Address is entered, you confirm in this window
with the button SetIP to assign this address to the net-
NODE.
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Hinweis: Diese IP Adresse ist nur temporär eingestellt.
Eine permanente Speicherung der IP-Adresse erfolgt
erst mit dem Systemkonfigurator SyCon, wie im
Abschnitt ‘Konfiguration des netNODE’ beschrieben.

Hinweis: Zum Einstellen der IP-Adresse muss sich das
netNODE im gleichen Ethernet Netzwerk (Subnetz-
werk) wie der verwendete PC befinden. 

Note: This IP Address is only temporarly adjusted. A
permanent storage of the IP Address takes place only
with the System Configurator SyCon, as described in
section ‘Configuration of the netNODE’. 

Note: To set the IP Address the netNODE has to be in
the same Ethernet network (Sub network) as the used
PC.
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Konfiguration des netNODE

Die Konfiguration des netNODE erfolgt über eine seriel-
le oder eine TCP/IP Verbindung.

Starten Sie den Systemkonfigurator SyCon und wählen
Sie das Menü Datei > Neu > netDEVICEs.

Rufen Sie nun das Menü Einfügen > Gerät auf und
wählen Sie das gewünschte Gerät aus, und bestätigen
Sie diese Auswahl mit OK.

Es erscheint nun ein weiteres Fenster, in dem Sie die
Protokolle für die Umsetzung bestehend aus 
• Ethernet Protokoll und
• seriellem Protokoll
auswählen müssen.

Mit dem Menü Einstellungen > netNODE Parameter

oder einem Doppelklick auf das Gerät öffnet sich das
Parameter Fenster. Stellen Sie die IP-Adresse (ggf.
auch die Netzmaske und die Gatewayadresse) sowie
die Parameter (insbesondere die Stationsadresse und
die Busparameter) ein.

Stellen Sie mit Einstellungen > Gerätezuordnung >

CIF TCP/IP Driver und Angabe der IP-Adresse eine
Verbindung mit Connect to Server oder mit Einstel-

lungen > Gerätezuordnung > CIF Serial Driver und
Verbinde COMx eine Verbindung zum netNODE her. 
In der Geräteauswahl ist dann das Gerät anzuhaken. 

Mit dem Menü Online > Download führen Sie einen
Download auf das Gerät durch. 

Nach dem Download führt das netNODE selbständig
einen Reset durch. Danach ist die neu eingestellte IP-
Adresse gültig.

Configuration of netNODE

The configuration of the netNODE is made via a serial
or a TCP/IP connection.

Start the System Configurator SyCon and select the
menu File > New > netDEVICEs.

Now call up the menu Insert > Device and select the
desired device. Confirm this selection by clicking the
OK button.

Now a further window appears where you have to sel-
ect the protocol conversion which exists of
• Ethernet Protocol and
• serial Protocol.

With the menu Settings > netNODE Parameter or a
double click on the device the Parameter window
opens. Set the IP Address (if necessary also the Net
Mask and the Gateway Address) as well as the parame-
ter (especially the Station Address and the Busparame-
ter).

Built up a connetion to the netNODE with Settings >

Device Assignment > CIF TPC/IP Driver, type in the
IP Address and press the Connect to Server button or
built up the connection by selecting the menu Settings

> Device Assignment > CIF Serial Driver and press
the Connect COMx button. You have to enable the
device in the device assignment by selecting it in the
check box.

With the menu Online > Download you make a down-
load to the device.

After the download the netNODE executes indepen-
dently a reset. Afterwards the new set IP Address is
valid.



Fehlersuche

Ethernet TCP/IP Schnittstelle

• Überprüfen Sie die Netzwerkeinstellungen Ihres PCs.
• Mit dem ping Befehl in der Eingabeaufforderung

Ihres Betriebssystem können Sie leicht prüfen, ob
eine Verbindung über TCP/IP zu dem Gateway mög-
lich ist. Öffnen Sie dazu eine Eingabeaufforderung
Ihres Betriebssystems, tippen Sie ping

192.168.10.215 ein (die IP-Adresse muß der einge-
stellten Adresse des Gateways entsprechen) und
drücken Sie die Return-Taste. Besteht eine Verbin-
dung, wird dies durch den Text Antwort von

192.168.10.215 ... bestätigt. Ansonsten wird eine
Zeitüberschreitung angezeigt.

Kabel

• Prüfen Sie, ob die Pinbelegung des verwendeten
Kabels richtig ist.

Diagnose mit dem Systemkonfigurator

• Zeigen Sie mit Online > Erweiterte Gerätediagnose

die Diagnoseinformation des Gerätes an.
Genauere Informationen über die Erweiterte Gerätedia-
gnose und deren Funktionen finden Sie im Bedienerma-
nual SyConND / Systemkonfigurator netDEVICEs.

Diagnose über netNODE Display

• Erscheint in der unteren Zeile des netNODE Displays
die Meldung ERR, ist ein Fehler aufgetreten.

Genauere Informationen über Fehlermeldungen durch
das netNODE Display finden Sie im Abschnitt ‘Diagno-
se über das Display’ auf der folgenden Seite.

Troubleshooting

Ethernet TCP/IP Interface

• Check the network settings of your PCs.
• With the ping command in MS-DOS Prompt you can

easily check if a connection via TCP/IP to the Gate-
way is possible. Open the MS-DOS Prompt and enter
ping 192.168.10.215 (the IP address has to be the
same as set in the gateway) and press the Return
key. Could a connection be established then the
answer is displayed by the following text Reply from

192.168.10.215 ... Otherwise a connection timeout is
displayed. 

Cable

• Make sure that the pin occupation of the used cable is
correct 

Diagnostic using the System Configurator

• Display the diagnostic information of the device using
Online > Extended Device Diagnostic.

More information about the Extended Device Diagnostic
and its functions you find in the operating manual
SyConND / System Configurator netDEVICEs.

Diagnostic via netNODE Display

• If the information ERR appears in the belower line of
the netNODE Display, an error has occurred.

Further information about error reports in the netNODE
Display you find in section ‘Diagnostic via the Display’
on the next page.
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Diagnose über das Display Diagnostic via the Display
Das Display des netNODE ist ein zweizeiliges alphanu-
merisches Display mit 16 Zeichen pro Zeile. Mit den 6
Eingabetasten ist eine Parametrierung und Diagnose
der zu koppelnden Protokolle möglich.
Das Online Bild, welches nach Anlaufen des netNODEs
auf dem Display erscheint, ist die Standardeinstellung,
in der sich der netNODE befindet, wenn keine Diagnose
oder Parametrierung durch den Anwender stattfindet.

RDY zeigt an, dass das Betriebssystem des 
netNODEs läuft

RUN zeigt an, dass alle Tasks angelaufen sind
COM zeigt an, dass die Kommunikation läuft
/ der Rotating Slash (dreht sich) zeigt an, 

dass der netNODE fehlerfrei läuft
___ wenn die Anzeigen RDY, RUN und/oder 

COM erlöschen, wird an dieser Stelle ein 
___ angezeigt. Ein Fehler ist aufgetreten.

Im Falle eines aufgetretenen Fehlers wechselt der
Rotating Slash / in ein Ausrufezeichen ! und die Anzei-
gen RUN und COM können, je nach Fehlerart erlö-
schen.

Diese Fehlermeldung beispielsweise zeigt an, dass an
den Task 1 und 3 ein Fehler aufgetreten ist.
Durch Anwählen des Menüs Diagnostic lassen sich die
Diagnosefunktionen des netNODEs aufrufen. Die Dar-
stellung des Untermenüs Diagnostic hängt von der
geladenen Umsetzung ab, und ob netNODE 40 (eine
serielle Schnittstelle) oder netNODE 42 (drei serielle
Schnittstellen) verwendet wird. 
Genauere Informationen zur Bedienung des netNODE
Displays finden Sie im Manual netNODE 40/42 auf der
netDEVICE CD.

The display of the netNODE is a two-lined alphanumeri-
call display with 16 characters per line. With the 6 keys
you can do parameterization and diagnostic of the pro-
tocol which have to be coupled.
The Online Display which appears after start-up of the
netNODE is the standard setting. The netNODE always
shows this when no diagnistic or parameterization is
done by the user.

RDY shows, that the operating system of the 
netNODE is running

RUN shows, that all tasks are started
COM shows, that the communication is running
/ the rotating slash (rotates) shows, that 

the netNODE is running faultless
___ if the display of RDY, RUN and/or COM go

out, a ___ is displayed at this position. An 
error has occurred.

If an error appears the rotating slash / changes into an
exclamation mark ! and the display RUN and COM go
out depending on the error type.

This error report for example shows, that an error has
occured at the tasks 1 and 3.
By selecting the menu diagnostic you have the possibili-
ty to call up the diagnostic functions of the netNODE.
The display of the submenu diagnostic depends on the
loaded protocol conversion and if netNODE 40 (one
serial interface) or netNODE 42 (three serial interfaces)
is used.
More information about operating with the netNODE
Display you find in the Operating Instruction netNODE
40/42 on the netDEVICE CD.
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Technische Daten / Technical Data
netNODE 40 / netNODE 42

Ethernet Schnittstelle / 

Ethernet Interface
Übertragungsrate / Transmission rate 10 MBit/s
Controller / Controller CS8900A
Schnittstelle / Interface 10Base-T, potentialfrei / isolated
Steckverbinder/ Connector RJ45

Serielle Schnittstelle / 

Serial Interface NRZ, NRZI
Übertragungsrate / Transmission rate 50 bis / to 19,2 kBit/s
Duplex Modus / Duplex mode Halbduplex / Half duplex
Schnittstelle / Interface RS232C, RS422, RS485 potentialgebunden / not isolated
Steckverbinder / Connector 9-polige DSub Stecker / 9-pole DSub male connector
Diagnoseschnittstelle RS232C, 9600 Bit/s, potentialfrei / isolated
Diagnostic Interface (nur mit Zubehör CAB-NN nutzbar / only usable with the equipment CAB-NN)

Betriebsspannung +24 V (18 .. 30 V) 
Power Supply 200 mA / 24 V

Betriebstemperatur / 0 °C - 50 °C
Operating Temp.
Schutzart / Safety Type IP 20

Maße (L x B x H) 130 x 110 x 80 mm
Dimensions (L x W x H) 
Gewicht / Weight ca. 500 g
Anzeige / Display LCD Display mit 2x16 Zeichen / LCD Display with 2x16 characters
Bedienelement / Operating Element 6 Tipptasten / 6 push buttons
Montage / Mounting Tragschiene DIN EN 50022 / DIN rail 50022 
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ReservedReserviert
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Haftungsausschluss

Der Inhalt dieses Manuals wurde auf Übereinstimmung
mit der beschriebenen Hard- und Software geprüft.
Dennoch können Abweichungen nicht ausgeschlossen
werden, sodass wir für die vollständige Übereinstim-
mung keine Gewähr übernehmen. Die Angaben in die-
sem Manual werden jedoch regelmäßig überprüft. Not-
wendige Korrekturen sind in den nachfolgenden
Auflagen enthalten. Für Verbesserungsvorschläge sind
wir dankbar.

Exemption from Liability

The contents of this manual were checked for agreement
with the described hardware and software. However,
deviations may occur so that no guarantee can be made
for complete agreement with the documentation. 
However, the information in this manual is controlled
regularly. Necessary corrections are contained in the
following editions. We are grateful for improvement
suggestions.
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Rheinstrasse 15

65795 Hattersheim

Phone:  +49 (0) 6190 9907-0

Fax:    +49 (0) 6190 9907-50

E-Mail:  info@hilscher.com

Web:     www.hilscher.com

World-wide: Distributors
Please visit our homepage on
www.hilscher.com 

Subsidiaries

France

Hilscher France S.a.r.l.

12, rue du 35 ième Régiment d`Aviation

Miniparc du Chêne 

69500 Bron

Phone:  +33 (0) 4 72 37 98 40

Fax:      +33 (0) 4 78 26 83 27

E-Mail:  info@hilscher.fr

Web:     www.hilscher.com

Italy

Hilscher Italia srl

Via Grandi, 25

20090 Vimodrone (MI)

Phone:  +39  02 25007068

Fax:      +39  02 25029973

E-Mail:  info@hilscher.it

Web:     www.hilscher.com

Switzerland

Hilscher Swiss GmbH

Hubelmattstrasse 29

4500 Solothurn

Phone:  +41 (0) 32 623 6633

Fax:      +41 (0) 32 623 6632

E-Mail:  info@hilscher.ch

Web:     www.hilscher.com

USA

Hilscher North America, Inc.

Suite 100

2443 Warrenville Road

Lisle, IL 60532

Phone: +1  630-505-5301

Fax:      +1  630-505-7532

E-Mail:  info@hilscher.us

Web:     www.hilscher.com



netNODE

Bei weiteren Fragen wenden Sie sich

bitte an eine unserer Geschäftsstellen, 

Ihren lokalen Distributor

oder an unseren technischen Support:

If you have any question 

please contact our subsidiary, 

your local distributor 

or our technical support:  

Phone: +49 (0) 6190 9907-99 

E-Mail: hotline@hilscher.com
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